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Microsoft Knowledge Base Article - 161725 

OL97: What Are Offline Folders and How Do You Use Them?

This article was previously published under Q161725 

SUMMARY

When you use Microsoft Outlook 97 with the Microsoft Exchange Server Information Service, you have the ability to work with folders "offline." That is, you can use the contents of a folder without a network connection, which is beneficial for remote users. This article discusses how you can create, use, and synchronize offline folders. 

MORE INFORMATION

Offline folders are the quickest and easiest way to work offline with Microsoft Exchange Server. Offline folders make it possible to take a folder from the Exchange Server location, work with the contents of the folder and when connected to the network, update (synchronize) the folders to make them identical. 

Offline folders are stored in an offline folder file (OST). This file is located on your computer hard disk. The default location for the OST is your current Windows folder and is available even when the network is down. Like Personal Folders (PST), the OST can be compacted to save space on your computer. 

The difference between an Offline Folder file and a set of Personal Folders is that the Offline Folder file starts as a mirror image of your folders on the Exchange Server and works in conjunction with the Server during synchronization. A set of Personal Folders, on the other hand, is simply a storage location on your local disk or on a server other than the Exchange Server. 

When working offline, you can add, delete, and modify the contents of an offline folder exactly as you do with a folder on a server. For example, you can change and move items in your offline Inbox, send messages that are placed in your offline Outbox, and read your offline public folders. In the meantime, information on the server is still processing. You will continue to receive new messages in your Mailbox while other users can add, delete, and change items in public folders. However, you will not be aware of these changes on the server until you connect to the network. 

When you need to update the contents of the Offline folder and its corresponding server folder so that they are identical, you synchronize the folders and then continue to work offline. The Synchronize command (on the Tools menu) connects to the server through Dial-Up Networking, copies the changes made in each folder to the other folder, and then disconnects. Any item that you delete from either the offline folder or the corresponding server folder will be deleted from both after synchronization. 

NOTE: Offline folders are only available with Microsoft Exchange Server. 

Creating an Offline Folder File

To create an offline folder file, follow these steps: 

1. On the Tools menu, click Services. 

2. In the Services dialog box, select Microsoft Exchange Server, and then click the Properties button. 

3. In the Microsoft Exchange Server dialog box, click the Advanced tab, and then click the Offline Folder File Settings button. 

4. In the Offline Folder File Settings dialog box, in the File box, type the path to the file you want to use as the offline folder file. 

5. If the message stating that the "<path><filename>.ost could not be found. Would you like to create it?" appears, click the OK button. 

6. Click OK and OK. 

NOTE: The client must be connected to the Exchange Server for the initial creation and synchronization of the Offline Folder file. 

All of the standard Outlook folders (Inbox, Outbox, Deleted Items, Sent Items, Calendar, Contacts, Journal, Notes, and Tasks) on the Exchange Server are now ready for offline use. You cannot selectively choose which will be available for offline use and which will not be available. The exceptions to this are Public Folders and any user defined folders. To set Public Folders for offline use, see the Working with Public Folders Offline section later in this article. 

To set any user-defined folders for offline use, follow these steps: 

1. Right click on the user-defined folder and click Properties. 

2. Click the Synchronization Tab and select "When offline or online" from the "This folder is available" section. 

3. Click OK. 

You cannot use an OST file that had previously been used with a different mailbox. Doing so produces the following error message: 

The file <filename>.ost cannot be accessed because it has been configured for use with a different mailbox. NOTE: When logging into Windows, you cannot press ESCAPE when prompted for the Windows password. If you do, you will not be able to access the OST because the proper credential information has not been supplied. This is a security feature. 

Working with Public Folders Offline

To work with public folders offline, follow these steps: 

1. Using the right mouse button (right-click), click the public folder that you want to work with, and click Copy "<FolderName>" on the shortcut menu. 

2. In the Copy Folder dialog box, move to your Favorites Folder, and click OK. 

3. From your Favorites Folder, right-click the newly copied folder, and click Properties on the shortcut menu. 

4. Click the Synchronization Tab and select the "When Offline or online" option under the "This folder is available" section. 

5. Click OK. 

Your Public Folder is now ready for offline use. Each folder that you copy to your Favorites Folder can now be selectively set for offline use. 

To synchronize offline folders, use one of the following methods. 

NOTE: When you synchronize, a log file appears as a message in your Deleted Items folder. This log file contains information such as the time you synchronized, the names of the folders synchronized, and the number of items added. 

Synchronizing a Specific Folder

To synchronize a specific folder, click the folder you want to synchronize, click Synchronize on the Tools menu, and then click This Folder. 

Synchronizing All Folders

To synchronize all your offline folders, on the Tools menu, click Synchronize and then click All Folders. 

Automatically Synchronizing All Folders When You Quit Outlook

To automatically synchronize all folders when you quit Outlook: 

1. Click Options on the Tools Menu. 

2. Click the General tab and click to select "When online, synchronize all folders upon exiting." 

3. Click OK. 

All folders which are set to be available while offline will now be automatically synchronized when you quit Outlook. It is important to Synchronize and download the Address book before you logoff from your Exchange Server when going on the road. This is particularly important when going on the road for the first time. This will ensure that all your offline folders will be updated before you leave. 

To download your address book, use the following steps: 

1. Click Synchronize on the Tools menu and select Download Address Book. 

2. Select to either Download the offline address book with or without details information and click OK. 

Note that the Download Offline Address Book dialog contains information concerning the ramifications of downloading without detail information. 

NOTE: Outlook's Remote Mail feature is not available if you are set for Offline Folder Use. For more detailed information about Remote Mail and how to use it, please see the following article in the Microsoft Knowledge Base: 


162046 OL97: Remote Mail, Offline Folders, and Working Offline 

The information in this article applies to:

· Microsoft Outlook 97
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Microsoft Knowledge Base Article - 172072 

OL97: Troubleshooting Synchronization Problems

This article was previously published under Q172072 

SUMMARY

This article describes how to troubleshoot problems synchronizing your Microsoft Exchange Server Mailbox with your offline folders file, sometimes called the offline store (*.ost). 

MORE INFORMATION

Follow these steps to determine if your offline folders are synchronizing: 

7. Using the right mouse button, click your Inbox or the folder you want to check, and from the context-sensitive menu, click Properties. 

8. Click the Synchronize tab.

NOTE: If you do not have this tab, you did not setup your profile to use offline folders. 

9. Under "Statistics for this folder", check the following settings: 

     Last Synchronized on:        Date

     Server folder contains:      # Items

     Offline folder contains:     # Items

With synchronization, the number of items should match for the server and offline folders. If no synchronization is occurring, or if synchronization does not occur correctly, between the server folder and the offline folder, check the following items: NOTE: Your profile must include the Microsoft Exchange Server service and the Microsoft Exchange Server Mailbox has to be your default delivery location. Offline folders can only synchronize with a Microsoft Exchange Server Mailbox. 


Follow these steps to check your profile settings: 

10. On the Tools menu, click Services. 

11. On the Services tab, verify that the profile includes Microsoft Exchange Server. 

12. Click the Delivery tab. 

13. In the "Deliver new mail to the following location", box make sure "Mailbox - <account name>" is selected. 

· Even when you are not connected to a network, you must still log on to Windows to gain access to your offline folders file and password lists. Make sure when you start Windows that if you are prompted for a password you type the password and click OK. If you click Cancel, Windows will start without logging you in. 

· Make sure you are logged on to your local area network when you synchronize. You cannot gain access to your Exchange Server Mailbox unless you log on to the network. 

· Use either the manual or the automatic method listed below to initiate synchronization. 

NOTE: An OST file cannot be moved to a new location, and you cannot synchronize it with a different Microsoft Exchange Server. Any change of this nature will break the link between your OST and the server and render the OST unuseable. 

Manual Synchronization

Select the folder you want to synchronize and on the Tools menu, click Synchronize and then click This Folder to synchronize one folder or All Folders to synchronize all offline folders. When synchronization begins you should see a progress bar on your screen. If you have many items in your Mailbox and you have not synchronized for a while, the synchronization may take a long time. 

Automatic Synchronization

The following steps cause Outlook to synchronize all offline folders automatically each time you are online and quit Outlook: 

4. On the Tools menu, click Options. 

5. Click the General Tab. 

6. Click to select "When online, synchronize with all folders upon exiting." 

Damaged Offline Folder

If all folders except the Inbox synchronize, or you cannot synchronize, you may have a damaged offline folders file. To correct this problem disconnect from the damaged offline folders file and create a new offline folders file. Since your offline folders file is a replication of the information stored on your Microsoft Exchange Server Mailbox, this procedure should not destroy any information. 

Follow these steps to create a new offline folders file: 

6. From the Tools menu, click Services. 

7. In the services list, click to select "Microsoft Exchange Server" and click Properties. 

8. Click the Advanced tab. 

9. Click "Offline Folder File Settings." 

10. Click Disable Offline use, and then click Yes. 

11. Click "Offline Folder File Settings." 

12. In the File box, type a different name for the OST file. 

13. Click OK three times to close all dialog boxes. 

14. Use the manual synchronization method above to synchronize your new OST file with your Microsoft Exchange Server Mailbox. 

Damaged Microsoft Exchange Server Support Files

Removing and reinstalling the Microsoft Exchange Server service support files for Outlook is a two step process. To do this you must: 

· Manually delete the service support files. 

· Replace the deleted files with the original Outlook files. 

Remove the Exchange Server Service Support Files

To remove the Microsoft Exchange Server service support files, follow these steps: 

4. Click Start, point to Programs, and then click Windows Explorer. 

5. Navigate to the \Windows\System folder and rename or delete the following files: 

Emsabp32.dll

Emsmdb32.dll

Emsui32.dll

Emsuix32.dll 

NOTE: The default location is C:\Windows\System for Windows 95/98 or C:\Winnt\System32 for Windows NT. 

Replace the Microsoft Exchange Server Service Support Files

To replace the deleted support files from the original media, follow these steps: 

3. Click Start, point to Settings, and then click Control Panel. 

4. In Control Panel, double-click the Add/Remove Programs. 

5. Click Microsoft Outlook 97 and then click Add/Remove. 

6. Run the setup program to re-install Outlook 97.
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Microsoft Outlook 2000: Office's Killer App Just Keeps Getting Better

Thomas Rizzo
Microsoft Corporation

November 1998

Summary: Discusses the enhanced features included in Microsoft® Outlook® 2000, which has been tightly integrated with Microsoft Office 2000 to become the premier Internet-based messaging system. (10 printed pages)

Introduction

With Outlook 97, Microsoft delivered a breakthrough product based on a unique vision to combine support for the following capabilities in a single application: 

· E-mail 

· Personal calendar and group scheduling 

· Personal information, such as contacts and tasks 

· Custom collaboration and information-sharing applications 

Outlook 98 and, now, Outlook 2000 build on the original Outlook product vision, particularly in the areas of Internet standards support, ease of use and simplicity, and support for collaborative solutions. As a result, Outlook 2000 is the premier messaging and collaboration client for Internet-based messaging systems, as well as for the fast-growing number of customers who use Microsoft Exchange Server for advanced messaging and collaboration on their corporate intranets.

Released in March of 1998, Outlook 98 included major enhancements that reduced complexity, improved performance, and provided industry-leading support of Internet standards. Outlook 98 essentially swept the competitive e-mail client reviews, winning on the strength of its e-mail, the advantages of tight integration with Calendar and Contact management, the ease of its setup, and the simultaneous power and simplicity of new features, such as Outlook Today and the Organize and in-place Find tools.

Outlook 98's strengths are enhanced in Outlook 2000 and, when combined with new features and tight integration with Microsoft Office 2000, Outlook 2000 becomes the place where users can store, access, and act on virtually all their important information and communications.

Better E-mail

E-mail is Outlook's forte. Outlook 2000 leads the industry in supporting Internet standards and providing powerful tools that let users effectively manage their e-mail.

Outlook 97 supported using Microsoft Word 97 as its editor. Outlook 2000 enhances this significantly, containing support for Microsoft Office E-mail, which provides a standard e-mail toolbar that allows users to address and send any Microsoft Office 2000 document from within the application that created it. And the message can be sent as HTML, so the recipient need not have the specific Office application to read the message. Outlook 2000 supports HTML, plain text, and rich text format files in the bodies of e-mail messages. This gives users flexible control over the format in which they send messages, and makes the choice of editors independent of the choice of the e-mail body format.

Outlook 97 featured an add-on named the Rules Wizard interface, a powerful yet intuitive mechanism for creating server or client-side rules. Outlook 2000 integrates the Rules Wizard as a built-in feature, allowing users to apply rules they've created for mail already in their inboxes or other folders, as well as to support rules that print messages or pass them to custom executables. Outlook 2000 also adds support by using the Rules Wizard with IMAP4 mail servers.

Better Calendar, Contact, and Task Management

Most Outlook users also avail themselves of Outlook's Calendar, Contact, and Task Management features. These users are in for a treat.

First, Calendar views have been fine-tuned, with support for word-wrap, ScreenTips over text that doesn't fit within the space for the appointment, the ability to customize the background color of the calendar for easier reading, the ability to hide private appointments in printouts, and an improved Calendar Details printout style.

For users who take advantage of advanced Group Scheduling with Microsoft Exchange Server, Outlook 2000 has some powerful enhancements (see Figure 1). A few examples include an easier-to-use meeting planner, support for Distribution-list (aliases) expansion in the planner, improved support for updating the attendees of an existing meeting, and the ability to directly book resources, such as conference rooms (rather than sending them a piece of e-mail).
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Figure 1. The improved Meeting Planner in Outlook 2000
Users who manage other people's calendars will breathe a sigh of relief with a list of most recently opened calendars—from which any can be opened—as well as the added support for hiding details of some appointments, even from those who have access to your calendar.

Outlook 2000 also supports basic group scheduling with users reached via the Internet, using the Internet iCalendar standard. And Outlook goes beyond simply scheduling meeting times, with support for scheduling Microsoft NetMeeting® and Microsoft NetShowÃ‚Â™ sessions. And while we're talking about groups, Outlook 2000 allows users to store personal Distribution lists in the Contact folder, enabling them to be viewed alongside individual contacts.
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Figure 2. Linking contacts in Outlook 2000 makes it easy to create shortcuts to other items on a single contact.
Many users asked for the ability to organize information in Outlook according to whom it relates. These users will appreciate the new Contact Activity Tracking feature. Contact Activity Tracking allows you to associate any item, programmatically or through the user interface, with anyone in your Contact list (see Figure 2). E-mail messages, meeting requests, tasks, or any other item sent to, or received from, the contact will automatically be associated. Outlook then allows you to view this associated data from a new tab on the Contact item (discussed in detail later in this article in the section "The Outlook 2000 Programming Model and Office COM Add-ins").

A Better Place to Live

More and more users are finding e-mail is their critical mode of communication. As e-mail replaces many phone calls, letters, and faxes, e-mail clients are becoming the central applications on users' computers. Outlook 2000's tight integration of Calendar, Contacts, and Tasks with this e-mail functionality naturally makes users more effective. However, they also want the ability to access the key remaining information they need—the Web—from within Outlook.

Outlook 2000 addresses this need by providing Web Views: the ability to host and browse frequently used Web pages in the right pane of the Outlook window. Users can drag Internet shortcuts into the Outlook Bar, and click on them to display the target page. Browsing functionality, such as Back, Forward, and Favorites, is also provided.

Outlook uses components of Microsoft Internet Explorer to deliver high-quality Web rendering that stays up-to-date with the latest technologies. Web pages can also be associated with a personal or Exchange Server public folder, providing a useful initial view on the folder and an easy way to associate Web content with the folder. The associate pages can provide useful instructions, links to key views of the folder, a custom search page, contacts, and other key information about the folder (see Figure 3).
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Figure 3. An Outlook Web View in a public folder in Outlook 2000. Now you can associate any URL with an Outlook folder.
A Better Place to Collaborate

In addition to providing industry-leading support for the most popular collaboration applications today—e-mail and group scheduling—Outlook 2000 includes a wealth of new object model enhancements and features that developers can use when creating discussion, routing, and tracking applications.

Outlook 2000 further enhances the Exchange Server public folder experience beyond Outlook 97 with support for background, automatic, and filtered synchronization of Offline folders (see Figure 4). In addition, a new Find Public Folder feature allows users to search the entire Microsoft Exchange hierarchy for folders that meet their criteria. There is also a one-click method to send a public folder link to another user who may be interested.
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Figure 4. Setting up offline synchronization in Outlook 2000 is a snap with this new streamlined interface.
The Outlook 2000 Programming Model and Office COM Add-ins

The success of Outlook 97 and 98 as tools for collaborative solutions has been impressive. Solution developers have delivered outstanding examples of integrated applications using Outlook and Exchange. With Outlook 2000, the Outlook team has expanded the scope of solutions developers can create. Responding to customer requests, the Outlook team has focused on some fundamental design goals in delivering this new version: 

· Provide greater developer control over Outlook 

· Provide more feedback on user actions to the developer 

· Eliminate the requirement to use Exchange Client Extensions when developing simple solutions 

To this end, the Outlook 2000 Object Model adds more than 10 new objects, more than 25 new methods, more than 30 new events, and about 50 new properties.

Moreover, while Outlook 97 and 98 have been remarkable successes in the collaboration development arena, many developers have encountered limitations in the breadth of solutions they can create. One of the key limitations was the lack of events Outlook fired. Before Outlook 2000, events in Outlook were only fired at the item (form) level. This meant a developer was only notified when something happened at this level, that is, an item was opened, data in the item was changed, the item was closed, and so on.

The introduction of Outlook 2000 ushers in a new era for collaborative application development by expanding the Outlook Programming Model considerably. For example, events now fire when new mail arrives in a user's Inbox, when a new item is added to a folder, and when a user changes the selected item(s) in a view. There is also now a complete object model around the Outlook Bar, so developers can programmatically create or delete new Outlook Bar groups and shortcuts.

While a massively expanded programming model is important, it's only half the story. Without a methodology for trapping more events with Outlook, all this work would be inaccessible to developers because, in Outlook 97 and 98, one could only write code as VBScript behind a form. Enter Microsoft Office COM add-ins, or COM add-ins for short. In brief, COM add-ins provide the architecture for developing components that can be plugged into any Microsoft Office application.

Let's take a close look at Outlook 2000's enhancements and what they mean.

The Outlook 2000 Object Model

The foundation behind any customizable application is its object model. Since Outlook 97, developers have been able to access and manipulate Outlook from Microsoft Visual Basic®, Visual Basic for Applications, or any other COM-compliant language via its object model. One of the first things savvy Outlook developers will appreciate about the new version is the addition of numerous events. Outlook 2000 includes new events on almost all existing objects, as well as some new special interfaces. Let's take a look at some of the benefits developers will inherit from this work.

Table 1. Some of Outlook 2000's New Events
PRIVATE
Event
Object
Description

NewMail
Application
Event that fires when new mail arrives in the Inbox.

NewExplorer, NewInspector
Application
Notification when a new Explorer object or Inspector object is created — either via the UI or programmatically.

ItemSend
Application 
Notification when an item is sent. This event is cancelable so developers can stop the item from being sent.

ItemAdd, ItemChange, ItemRemove
Items Collection
Within any folder, you can receive notification when an item is added, changed, or removed.

BeforeFolderSwitch, BeforeViewSwitch
Explorer 
For any given Explorer, an event is fired each time the user attempts to change to a different folder or change the current view of the active folder. These events are cancelable so developers can prevent the action.

FolderAdd, FolderChange, FolderRemove
Folders Collection
Developers asked us for a way to know when a user creates a new folder, changes an existing folder, or deletes a folder. These events enable that notification.

Powerful control over user interaction. Of the enhancements to Outlook in version 2000, the ability to receive notification on user actions is probably the most notable. Outlook 2000 includes numerous events to tell the developer what's happening in Outlook—whether initiated by the application or by the user. The table shown in Figure 5 is just a small sample of some of the more compelling new events in Outlook 2000.

Greater ability to manipulate Outlook objects. Outlook 97 and 98 gave developers the ability to create custom solutions primarily by creating customized forms based on one of the standard Outlook item types (Mail, Appointment, Contact, and so on). This model is effective for a specific class of applications, but developers asked for more control over Outlook. Outlook 2000 adds a new level of control by exposing a number of new objects and providing additional methods to existing ones. For example, Outlook 2000 adds a set of objects to manipulate the Outlook Bar. These objects (OutlookBarGroup, OutlookBarShortcut, and OutlookBarStorage) give the developer the ability to programmatically create new Outlook Bar groups and shortcuts—or manipulate existing ones. In addition, new methods have been added to the Folders Collection Object to permit developers to easily create, change, or delete folders through Automation.

Outlook 2000 also boasts some new end-user features that are also incorporated into the object model. For example, Distribution Lists are a new item in Outlook 2000 that provide users with the ability to create lists of contacts typically used as a shortcut when addressing e-mail or scheduling a meeting with a group of users. Distribution Lists can contain members from the user's Contacts folder, the Microsoft Exchange Server Global Address List, and Contacts folders shared on Exchange Server. Distribution List items coexist with Contact items in a Contacts folder. Outlook 2000 exposes the Distribution List item in the Object Model as the DistListItem. Like any other standard item, it's customizable and can have script behind it. It also inherits all the standard Outlook item methods and events, such as Open, Close, and PropertyChange. In addition to the standard item methods, there are also new methods specifically for Distribution List manipulation.

Contact Activity Tracking is a new feature in Outlook 2000 that allows users to quickly find all e-mail, appointments, tasks, and other contacts related to activities with a particular contact. This is implemented by searching a user-configurable set of folders to find the related items, and by also supporting the inclusion of a link in any item to associate it with a specified list of contacts. For example, a user may have e-mail from a colleague regarding a specific customer. While the customer isn't a recipient or sender of the message, the user may still want to be able to track the item by the contact. Thus, the user links the item to the contact item for the customer being discussed. In addition, Contact folders and folders containing e-mail, appointments, tasks, and documents can be shared on Microsoft Exchange Server to create shared Contact Activity Tracking applications. Outlook 2000 includes programmatic interfaces so developers can create, read, or delete the links that relate to the items.

Eliminating the requirement to create Exchange Client Extensions for simple solutions. While certainly a sound customization environment, the Outlook 97 and 98 programming model often forced developers to rely on Exchange Client Extensions for some relatively simple solutions. Outlook 2000 makes creating simple solutions, well, simple. Indeed, it's expected that for more than 90 percent of the cases Microsoft discussed with developers, the new Outlook Object Model will be sufficient. Toward this end, Microsoft added objects such as PropertyPage(s) and PropertyPageSite, which allow developers to create custom Property pages for the Options and Folder Properties dialog boxes.

This makes it easy for a developer to provide a user interface for capturing data, specific to their solution, that needs to be persisted from session to session. Outlook 2000 also includes greater control over Attachments so that events are fired when a user attempts to create, or open, an Attachment. New object interfaces are included to control synchronization between the local Outlook mail storage and the Exchange Server. Also, in direct response to customer feedback, Outlook 2000 includes greatly enhanced support over the Command Bar and Tool Bar in both the Outlook Explorer (views) as well the Inspector (form) level.

Microsoft added so much to the Outlook Object Model in 2000 that the number of elements has almost doubled. Space limitations have allowed me to only scrape the surface of the new and enhanced developer features in Outlook 2000.

The low-down on Office 2000's COM add-ins. COM add-ins are an offspring of Visual Basic version 5.0's extensibility mechanism and apply specifically to Microsoft Office 2000 applications: Word, Excel, PowerPoint®, Outlook, and FrontPage®.

A single interface (IDTExtensibility2) provides five methods with which developers can write code. Each Office application is then responsible for notifying the loaded add-ins when specific events occur for which it has registered.

To illustrate, let's use the example of a COM add-in that displays a dialog box telling the user how many pieces of mail are in the Inbox each time a new piece of mail arrives. The Outlook event that is of interest to the COM add-in is the NewMail event that is fired by Outlook's Application object. The Outlook developer must declare this object variable WithEvents so the host will properly notify it when the event occurs. When Outlook boots, the COM add-in must notify Outlook that it is "interested in" the NewMail event, referred to as synching the event. You do this in the OnStartupComplete method code block. Then, each time Outlook receives a new piece of mail in a user's Inbox, it will notify the COM add-in. It's the code in the COM add-in that then displays the message box indicating how many items are in the Inbox.

Table 2. The IDTExtensibility2 Interface
PRIVATE
Interface Method
Host application fires this event when ...

OnConnection
... the add-in is connected to it.

OnStartupComplete
... it's finished initializing.

OnAddInsUpdate
... something changes in the collection of connected add-ins.

OnDisconnection
... the add-in is disconnected from it.

OnBeginShutdown
... it starts to shut down (close).

To make this work, however, the developer is required to implement the IDTExtensibility2 interface shown in Figure 6. Moreover, COM add-ins can be written in virtually any programming language—the only requirement being that it supports COM. It's extremely easy to create COM add-ins using Visual Basic.

The flexibility of Outlook 2000's improved object model, combined with the power of Microsoft Office COM add-ins, provides developers a much more efficient and pleasurable experience while expanding the breadth of solutions that can be developed.

Conclusion

With Outlook 2000, Microsoft Office 2000 advances the vision of a central workspace for all of a user's information and communication needs. More information can be found at http://www.microsoft.com/office/ and http://www.microsoft.com/outlook/.

Thomas Rizzo works as a Product Manager in the Microsoft Exchange Server Product Unit in Redmond, WA. He specializes in evangelizing development features in both Exchange and Outlook. You can reach Tom at thomriz@microsoft.com.

This material was originally published in Microsoft Office & VBA Developer magazine, and appears by permission of Informant Communications Group, Inc. (http://www.informant.com/mod/)
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Word :  Creating Simple Macros

by Karyn Stille, Your Virtual Software Trainer

What is a macro?  

Put simply, macros automate common tasks.  For example, let's say when you print out a particular document, you always have to print 5 copies.  You always need to go to the File/Print menu, select 5 copies, and choose OK to print.  Wouldn't it be nice if you could just press a keyboard shortcut or choose a button on the toolbar and have Word automatically print 5 copies?  That's what macros do.  Macros allow you to assign a keyboard shortcut or create a button on the toolbar for tasks you commonly perform and can save you oodles of time.  Macros are written in Visual Basic for Applications (VBA), but are easily created in Word with no knowledge of VBA.  The code is written for you! 

A macro can be created for virtually any task that you perform in Word.  The amount of steps is irrelevant.  You can even create a macro that automatically places certain text in a document with as many attributes as you'd like!  This is great if you need to place things like legal statements or disclaimers in a document. 

Macros are created with a recording device similar to a common tape recorder. Once you start recording your macro, a toolbar pops up with standard stop and pause buttons.  Let's use our example of creating a macro that automatically prints 5 copies of a document, and make one! 

Creating a Macro 

1. Open a blank document or open the document in which you would like to add a macro.  You can assign the macro to either be available to all documents, or just the document you currently have open. 

2. From the Tools menu, choose Macro and Record New Macro.  The Record Macro dialog box is displayed as shown below.
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3. Type a name for your macro as indicated above, and choose where to store your macro.  The drop down arrow will allow you to choose a document that you have open to store your macro in, or you can make it available to all documents by storing it in the Normal template.

4. Add a Description if you would like - this is helpful if you are creating a lot of macros and need to keep everything organized.  I usually just make the macro name something I can recognize, and leave the description as the default text.

Keep going!

5. To assign the macro to a toolbar button, choose Toolbars.  To assign the macro to a keyboard shortcut, choose Keyboard.  For the example we are using, we are assigning the macro to a keyboard shortcut.  That seems to be the preferred choice for most users.  The Customize Keyboard dialog box appears as shown below.
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6. On your keyboard, press the shortcut key combination that you would like to use.  For example, Alt+P.  Note that you are pressing the actual shortcut on your keyboard, not typing out the letters like you see in the graphic below.  The combination is automatically placed in the Press new shortcut key box, and Word tells you whether or not that shortcut is already assigned.  If the shortcut is already in use, try pressing a different combination.  You can use any number of combinations of Ctrl, Shift, and/or Alt with a letter or number.  If Alt+P was taken, I might have tried Alt+Shift+P.
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7. Once you have found a shortcut that is not assigned, the Assign button becomes active.  Choose Assign and Close.  After you choose Close, the recording of your macro immediately begins. 
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8. The Stop toolbar is displayed while you are recording, and your mouse has a small cassette icon attached to it.  This lets you know that Word is recording every move and click of the mouse you make until you choose the Stop Recording button on the Stop toolbar.  You can also choose the Pause Recording button on the Stop toolbar if you need to temporarily stop recording.  Choose the Pause Recording button again to continue.
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9. In our example, from the File menu we would now choose Print.  We would change the number of copies to 5, then choose OK.  You can have any number of steps for the task you are performing, and you can use any of the menus and tools available.  Every character you type and/or click of your mouse is recorded. Since our macro is a simple macro for printing 5 copies, we are now done recording.

10. Choose Stop Recording on the Stop toolbar.  The toolbar disappears, and you are finished!

11. Test your macro by pressing the shortcut key you have chosen.  In this example, Alt+P.  It should print five copies of the current document.

Note:  It is easy to get a bit nervous when recording a macro, much like if you were recording something on an actual tape recorder.  Remember, though, that Word is recording what you do and not the speed at which you do it.  Take your time and be sure it is exactly what you want.  If you make a slight mistake, don't panic!  Fix it and keep going - your mistake and fix is recorded in the macro, but macros execute commands so fast you won't even be able to tell.  If you totally mess things up, choose Stop Recording, delete the macro, and try again.

Deleting a Macro

To delete a macro when it is no longer needed, or to re-record a macro: 

1. From the Tools menu, choose Macro and Macros. 
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2. In the Macros dialog box, select the macro you want to delete, and choose Delete and Close.
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You would go to the same box to edit your macro with the Edit button.  However, this opens the Visual Basic Editor and unless you know VBA you may not be able to make the changes you would like.  If you need to make changes and are unfamiliar with VBA, it is best just to delete the old one and record a new one.

Once you see how fast and easy macros make your common tasks, you will be addicted!  Have fun automating!




Microsoft Office 2003: A New Strategy

September 18, 2003
By  Matthew P. Graven 
After so many versions, how much can Microsoft really change its Office suite? Depending on how you use it, the changes in Microsoft Office 2003 range anywhere from moderately useful to ground-breaking. Individual users running Office on a desktop will find the changes convenient but not necessarily essential. Nonetheless, the improvements are for the best and result in a more productive set of applications. Microsoft Word, for example, includes better change-tracking and annotation tools, additional views for working with documents, and other enhancements that make it easier to use. Meanwhile, Microsoft Outlook has had a fairly dramatic face-lift. The interface is better organized and generally more efficient. There are handy new features, such as the ability to look at shared calendars side by side, as well as a much-improved spam filter. A new application, Microsoft OneNote, looks to change the way we take notes when we want to save our thoughts and ideas. Integration among Office applications has gotten even stronger, making it easier to work with various types of data and move data from one application to another. 

While individuals will find these general improvements helpful, the big changes are aimed at users working in collaborative environments. With Office 2003, Microsoft has changed its strategy for the suite. In fact, rather than referring to the new version as a suite, Microsoft has dubbed it the Microsoft Office System. This is because the new features—the pith of Office 2003's improvements—extend beyond the desktop, making data available throughout the workplace.

Office 2003 is about collaboration. It's about efficiency and a streamlined workflow. To start, the new Office integrates well with an improved Microsoft SharePoint service, allowing workers throughout a company to collaborate and work on documents. A central SharePoint portal lets team members post files, participate in threaded discussions, link to dynamic Web content, generate tables based on information in corporate databases, and so on. More important, however, is that the Office 2003 applications tie directly into the corporate system. You can, for example, share Word documents without ever leaving Microsoft Word and chat with coworkers from within applications.

The new version also makes greater use of XML. A new product, Microsoft InfoPath 2003, lets you design templates that pull information from databases and enter it into forms, which are then saved to the corporate database. 

Meanwhile, data is no longer tied up in files and applications. Data typed into Excel, for example, can be made independent of Excel. It's actually XML data. Now, you don't need to print out an Excel spreadsheet and pass it to another department, which will rekey it into a different system; instead, the original Excel file can tie into the system and pass on the data electronically. In action, Office 2003 provides employees throughout the company access to up-to-the-minute data in real time. 

Until now, working with XML has required a certain level of expertise. Granted, to get your systems up and running, your IT department will need to understand the ins and outs of this XML system. But Microsoft has taken much of the difficulty out of the process, putting the power of XML into the hands of mainstream business users. With a bit of understanding, these users will be able to customize their own documents, creating a more efficient workplace.


Collaborating With Office 2003
September 18, 2003
By  Richard V. Dragan 
With earlier versions of Office, users had some handy though fairly limited tools for sharing documents. Realizing that few important documents are produced by a single person these days, Microsoft has significantly beefed up its collaboration tools, many of which are at the heart of Office's transformation from a suite to a system that goes beyond just client-side tools to a network of clients and companion servers.

[image: image11.png]








While there is nothing extra to install on clients for collaboration in Office 2003, you'll need to set up one of Microsoft's two current intranet portal offerings, Microsoft Windows SharePoint Services (free with Windows Server 2003) or the full-fledged Microsoft SharePoint Portal Server 2003 ($3,999 per server plus $71 per user). 

Both SharePoint products allow users to create browser-accessible workspaces around one or more documents. Each workspace can contain a set of members with varying rights to files, group calendars, and to-do lists, and Web links to related materials. 
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Fortunately, Office 2003 users don't need to run to their browsers every time they need to work on documents stored within a workspace. Word, Excel, and PowerPoint now contain a Shared Workspace task pane (on the right side of the screen by default). From here you can create new workspaces or jump to a library of shared documents (and links) for your team and then work together very intuitively in the same interface. A convenient toolbar running across the top of this pane provides access to tasks, members, and shared documents and links. 

Inviting users to a shared work session can be done through e-mail or built-in support for instant messaging via Microsoft Office Live Communications Server 2003. We like that you can see who is online, using built-in presence indicators. With IM, users can contribute to live discussions about shared documents. And a whiteboard feature lets users share text and drawings in real time.
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After a user opens a document, SharePoint keeps track of the version control, locking it for edits from other users, who can still read the document. Another option lets users get automatic document updates when changes are made.

A fantastic new feature lets members view and even edit documents together in real time, as if in a virtual meeting, as long as their systems are properly configured. (The mouse pointer disappears from your screen as different participants make changes.) Once the changes are saved, the document on the main SharePoint server is updated.

Overall, the Shared Workspace console is very intuitive, letting you work with others from within the familiar interface of applications like Word and Excel. The Shared Workspace task pane expedites finding collaborative features quickly, leaving the content pane available for standard viewing and editing. 

You and You but not You
To protect shared Office documents from falling into the wrong hands, support for information rights management (IRM) comes as standard equipment here. (For those not running the IRM component, Microsoft offers a Passport-based hosting service to authenticate users.) Available from within the File menu of each Office application, as well as from within the Shared Workspace, the documents can be marked as available for certain users only or marked "do not distribute." We marked an Excel budget as available only to selected users, and it could not be viewed by those outside a simulated group of managers. (Examining the raw bytes of this file proved that it was indeed encrypted.) By using digital keys to match user identities to content, Office 2003 can ensure your company's intellectual property remains safe. 

There is the briefest glimpse here of Microsoft's future plans for trusted computing, which locks down programs as well as content (though at the operating-system level) based on a user's digital identity. If your organization makes use of IRM, who you are determines what you can view and access in Office 2003.

Our Outlook
Outlook 2003 is also an impressively capable team player. Whenever you attach a file to an e-mail, Outlook offers to put the file in a SharePoint document workspace instead. This makes it easier for all intended recipients to work together on the same version. 

In addition, calendaring and scheduling are significantly improved. We like the program's new side-by-side calendar feature, which let us view another user's available dates and times next to our own. While users could negotiate a meeting in previous versions, there's nothing like being able to view someone's entire day planner to simplify scheduling. Team calendars are also available so that you can view upcoming events and appointments for your workgroup.

Get to the SharePoint
Since the best of Office's collaboration depends on SharePoint, we wanted to make sure that getting Windows SharePoint Services up and running wasn't too onerous. Fortunately, setup is really simple compared with that of traditional portal products. The server runs on top of IIS 6.0 in Windows Server 2003. It bundles Microsoft Data Desktop Engine as a database. (Connecting to SQL Server is also a database option.) We had a default SharePoint Web site going quickly. The site contained options for all the core shared content, like posted documents and pictures, contacts, events, and shared tasks.

Administering users in a portal environment can be demanding. SharePoint's administration strikes a good balance between granularity and ease of use. In testing, we used the standard Active Directory tools to model an organization of 100 users assigned to 10 departments, with overlapping groups for executives, managers, and the like. SharePoint made simple work of assigning reader, contributor, editor, and administrator rights through its slick, Web-based administration console. These core roles let you control who can access and modify content; they are exactly enough for a basic portal, though they will not permit highly customized workflows with approval from different players, as in a full-fledged portal. 

One of the strongest aspects of SharePoint is the impressive wizards for creating new sites and shared content automatically. Several standout tools surpass what we've seen in traditional portal space. Uploading content of all kinds is also a snap. In addition to posting from within the Office applications, we posted Word, Excel, and PowerPoint files, as well as Web links, from the SharePoint site itself. In particular, we admire the excellent support for uploading and organizing pictures. With integrated support for thumbnails and slide shows, posting image files for a simulated company picnic and corporate retreat was very simple. (The interface here is so smooth, we were tempted to use it for a personal photo library.)

For those with the rights to add and modify Web content, SharePoint has a number of guided step-by-step wizards that simplify creating new mini-sites for specific events, like meetings. We simulated a company-wide meeting and a more selective sales meeting. We are impressed that the automatically generated Web site offered about half a dozen default template options for different kinds of meetings, from those with agendas to more informal meetings. 

Notifications can be e-mailed as content changes (either in real time or as scheduled) so users can keep up to date. A busy team, of course, won't want to use alerts for every event, or mailboxes will become clogged; stick with the daily or weekly updates. Additionally, all content is marked new after it has been added or edited, which helps you find it. 

While there isn't extensive customization for the placement of portal elements within these sites, you can tweak content placement. In the new SharePoint, Microsoft has gone back to the drawing board with a revamped portal component model. Though it is still called Web Parts, it has been redesigned to provide support for all current browsers (not just IE) and more extensive support for XML. SharePoint Portal Server bundles many more such controls. (Microsoft and its partners are at work with hundreds of components due out shortly.) The basic set of parts in SharePoint Services presents shared data for Office.

SharePoint exposes the core areas of collaboration in a familiar interface centered around such Outlook staples as contacts, calendaring, and tasks, while adding some support for business essentials like threaded discussions, online surveys, and simple content management. In testing, we found the interface for creating surveys quite effective. Another wizard let us type in questions and responses, including numeric and multiple-choice answers. Graphical feedback of survey options makes it easy to see how users voted.

When posting files, you can mark content to expire, and SharePoint Services provides built-in versioning to track changes during the collaborative process. Getting a simple workflow approval process will probably mean turning to the more powerful SharePoint Portal Server. Though readers and contributors may be clearly defined, SharePoint Services offers little support for content approval via a chain of command that includes different kinds of users—editorial and legal, for instance.

Businesses will clearly need SharePoint Portal Server 2003 to integrate multiple sites and for extensive customization for new portal sections. BizTalk Server integration and connectors to standard ERP systems like PeopleSoft, sap, and Siebel also come standard in the full version, along with a library of Web Parts beyond the dozen or so that ship with the free SharePoint Services. Other enhancements in SharePoint Portal Server 2003 include personal Web pages for users and the ability to define and manage "audiences" for content more easily, plus improved full-text searching.

Come Together
With the almost instant portal access SharePoint Services affords, Office 2003 makes managing shared files and team resources easy. Using its well-thought-out wizards, individual teams can benefit from personalized content with minimal it intervention (as long Active Directory has been used to model departments and users beforehand). Like some of the best groupware, Office (with SharePoint) lets ordinary users build and manage content, including quickly adding new Web sites for particular projects or meetings.

Microsoft is clearly betting that through the common wiring of SharePoint, users will be able to tap into a wide range of Office 2003 functions via a Web browser. While more extensive customization will certainly require it input, the default portal makes a strong case for collaboration in the new Office. It puts sharing documents and all kinds of Office data, as well as events and notifications, into play for any organization, with minimal up-front investment of time and effort from the it folks. Overall, SharePoint Services raises the ease-of-use bar for lightweight portals. What SharePoint Services does it does really well—and that's to place collaboration at the forefront of the new Office. Microsoft has devised a polished portal-style interface that can jumpstart any workgroup into doing more together in Office.


Office 2003 for the Enterprise
September 18, 2003
By  Richard V. Dragan 
Microsoft has big aspirations for streamlining business processes using Office 2003. The key is XML and Web services. Microsoft's strategy is promising, but you will need some in-house XML expertise to set up the ideal system. 

According to a recent Gartner Research report, more than half of North American companies surveyed plan to invest in Web services for business-to-business transactions within the next two years. These Web services, which will rely on XML-based standards such as SOAP and WSDL, allow disparate systems and computers to talk to one other in an easily understood language. 
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But while an enterprise's servers, databases, and various processes may support XML, too many old-fashioned programs are creating noncompliant documents with data that is not XML-friendly. Take a budget created in Excel or an expense report created in Word, for example. The data in such documents is essentially locked inside and not easily moved to other systems that need it. Most likely, the expense reports will need to be entered into a corporate system, and someone will need to do this manually. 

Instead of effectively trapping corporate data inside Word, Excel, and Access, Office applications can now store it natively in XML, which means the data can easily move across machines and applications. For example, your company's standard format for budgets can be defined once, and then reports can be completed in Excel and consumed via Web services in an enterprise system. 

A new application, Microsoft InfoPath 2003 (available with Office 2003 Professional Enterprise Edition), simplifies bridging the gap between databases, XML schema, and Web services. The program is a very flexible form designer and filler that, in accordance with XML's promise, effectively separates the underlying data from its presentation, letting it be easily viewed and manipulated in the most appropriate manner. 

Down the InfoPath
InfoPath 2003 installs effortlessly as a separate tool within Office 2003. The program will be familiar to anyone who's seen Microsoft Visual Basic or almost any other modern programming tool. 
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We tested InfoPath using sample data from PC Magazine Labs' inventory system for tracking products, vendors, and items for review. First, we connected to an SQL Server 2000 database. (InfoPath also supports Access.) Connecting to other databases must be done via Web services. (Luckily, vendors like Oracle already provide this capability, but we would like to see the addition of OLE DB support for other databases.) 

A wizard let us select which tables and fields to include in our electronic form. This tool, which is comparable in difficulty to Excel's query designer, lets you point and click your way through designing queries. The wizard had no trouble with a single table, but with a more complex one-to-many join to track invoices and invoice details, the wizard required some tweaking. A second source for new forms is standard XML Schema files (with the extension .xsd). We had no trouble importing a model order form created with Microsoft Visual Studio .NET. 

Finally, we tried tapping into several simple Web services built with C#, which simulated processing orders for a sample online store. This met with mixed results. There is some debate over how to structure Web services—whether to use multiple calls to pass smaller amounts of data or fewer calls to send larger chunks of information. InfoPath generally requires the latter. If your Web services are highly focused (meaning they don't pass large XML documents back and forth), you should think about redesigning them. This is easy enough to do, but it was evident that tweaking Web service APIs is a fairly important step before jumping into InfoPath form creation. 

On the plus side, the Web services wizard lets you browse UDDI (Universal Description, Discovery and Integration) directories to locate available Web services and choose whether you will be sending and/or receiving XML calls. It then parses the WSDL (Web Services Description Language) and generates a form based on the shape of your Web service data.

In fact, from various data sources, InfoPath generates a default form, with labels and input boxes for all the fields in your file. Database tools and report generators have done this sort of thing for years, of course, but InfoPath is aimed at general business users rather than database programmers. And it does a good job, for the most part, at hiding the complexity from end users. 

There are about a dozen control types that can be placed on a form, including drop-down lists and repeater-type controls for creating repeating sections (for example, the details or line items common to many business documents). We found the repeating controls a little tricky, but we had little trouble generating a custom invoice form with multiple rows for shipped items. The resulting form automatically creates new rows to fit the data, which can save space in real-world forms if lines aren't always required. Certain kinds of forms will really benefit from such streamlining, since they can actually shrink and grow to fit the data at hand. And we appreciate that Office 2003 includes more than two dozen sample forms to work with, covering such items as absence requests, project-planning documents, meeting agendas, and purchase orders. 

Within InfoPath, it's generally easy to customize the positions of controls, and you can set properties and add validation to each control. Power users can even add VBScript and JScript statements for more complex processing.

When you are satisfied with your form, InfoPath saves it to an XML file with the .xsn extension. A quick look at our invoice form showed use of XML Schema including name spaces and attributes (with the schema stored on our SharePoint Services server when we published it for teams). Once your organization decides on the shapes of commonly used forms that fit your databases or Web services, reusing them is a cinch via the built-in shared library or team workspace window. 

In form entry mode, InfoPath turns into a facile data entry utility with powerful ease-of-use features. First of all, we like that all date fields can easily be selected using the standard calendar control. Using auto-complete, we easily picked by value, even for standard input boxes. For extensive data entry, you can expect users to type a lot less using this feature. For example, common phone numbers and ZIP codes can be reused effortlessly.

In our experience, InfoPath is a very capable data entry tool. With some additional effort (which will inevitably involve help from IT), you can get users to edit XML data in the software they are most familiar with, like Word and Excel. To use InfoPath forms with Word, you should create an XLST file in Microsoft FrontPage, which can apply visual formatting to raw XML. Without an XLST file, you can view and edit the contents of XML, which will display within tags. In Excel, you can import raw XML data into a row of cells in a spreadsheet. Still, we expect InfoPath will be used most of time for data entry. Although it will take some time to get everything set up for editing XML in Word and Excel, these features can be very useful for working with certain kinds of files, such as reports (in Word) or budgets (in Excel). 

Can an Acrobat Do This?
As a form designer/filler, InfoPath has some competition from Adobe Acrobat. Like InfoPath, Acrobat also supports smart forms that can be completed by users, and the latest version of Acrobat adds the ability to create custom XML as well. Meanwhile, Adobe is releasing a form designer that will compete with InfoPath. InfoPath's forms are generally not exact pixel-by-pixel duplicates of printed forms, as you get with Adobe Acrobat 6. And Adobe Acrobat Reader, being free and cross-platform, has far more reach than Microsoft could possibly get in the foreseeable future. We'd like to see Microsoft release a free or inexpensive version of InfoPath that could be used to fill in forms but without the design tools. Until InfoPath gets wider acceptance, we can't see it being used across companies or for consumer documents such as tax forms and loan applications. 
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For complicated business documents, however, InfoPath has the advantage of being a hybrid of print and digital technologies. You can easily add new line items for any number of parts on a purchase order, for example. An extensive 20-page business document that is mostly empty space can be condensed in InfoPath to only the pages that are filled in. For items like legal forms, which require perfect fidelity so a given document always appears exactly the same, the pixel-perfect approach of Adobe Acrobat has the advantage for mimicking printed documents. 

What It All Means To You
In the past couple of years, XML Web services have achieved impressive critical mass on the middle tier in today's enterprises. We've seen XML help wire together Wintel and other hardware, including legacy mainframes and Java/J2EE software. Microsoft is now attempting to help businesses take the next, surprisingly difficult step of getting employees to work in XML on the corporate desktop, ultimately bringing more corporate data into shareable systems. 

Overall, InfoPath is a promising technology. Integrating it into your enterprise will require some work on the IT end, but Microsoft is betting that the tool's ease of use will help desktop users and IT meet in the middle, using documents based on xml, without all the traditional difficulty surrounding this powerful though somewhat daunting set of standards. With the arrival of Office 2003 and the new InfoPath technology, Microsoft strikes a blow against duplicated effort in the business world—a move that could save time and money and improve competitiveness.


Microsoft Word 2003

September 18, 2003
By  M. David Stone 
For personal use on a desktop PC, Microsoft Word 2003 has changed relatively little from Word 2002. Where it has changed, though, has been for the better. Much of what is new and different applies to Office as a whole—including shared workspaces, information rights management, and other features covered elsewhere in this story. But there are several new features specific to Word, such as the Reading Layout view.

The Reading Layout view ignores line and page breaks as they show in the Normal and Page Layout views. This ensures that you see as much text at once as possible. In full-screen mode, the view divides the text into two snaking columns; as you narrow the window, the columns narrow. Narrow the window too far and the view snaps to one wider column. We found that text is far easier to read with two narrow columns, as opposed to the single column you get in the other views. 
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There are also some invaluable new Protect Document options. If you've ever spent time carefully creating styles for a document, only to receive versions back that are filled with manual formatting or unwanted styles, you'll love the new ability to limit formatting to styles only, using a list of styles that you define. If you send the document to collaborators, be sure to tell them what you did, or they may be confused when they can't bold, italicize, or make other formatting changes. 

Another new Protect Document feature lets you select sections of a document to protect from editing, then create a list of people who can edit each section. The feature didn't work on our tests, but Microsoft says that this is a known problem in the late beta version we looked at and that it will be fixed in the final release version. 

Other small but welcome touches include the option to call up the pre–Word 2002 dialog box for reviewing tracked changes, which restores the ability to find the next item automatically when you accept or reject a change (an option sorely missed in Word 2002). Similarly, a new Compare Documents feature lets you open two versions of a file in side-by-side windows that both scroll when you scroll either one. There's nothing here that you can't do manually, but the synchronous scrolling makes the mechanics of comparing documents a lot easier.


Microsoft Excel 2003

September 18, 2003
By Helen Bradley 
Most of the major improvements in Microsoft Excel 2003 involve workgroup functions, but there are a few enhancements that may tempt individual users to upgrade.

The key new Excel enhancement—XML, IRM (information rights management), and SharePoint aside—is its new List feature. This addresses some of the problems traditionally associated with lists—including the fact that the SUM function didn't work as you might expect on filtered lists. Once you've created an Excel 2003 list by clicking on Data | List | Create List, it's surrounded with a blue border showing clearly where it begins and ends. The last row in the list contains a single asterisk, much as you'd see in an Access table. Entering data in any cell in that row (within the list) inserts a new row in the list.

Every column has the AutoFilter enabled by default, which lets you quickly filter and sort the list. Totaling a column is as easy as clicking the Toggle Total Row button on the new List toolbar and choosing one of a range of functions for each column, such as Sum, Count, Average, Max, or Min. Excel lists can be published to a SharePoint site, keeping the local and server copies in sync if required.

There is a new Compare Worksheets feature, which you use by opening two workbooks and then choosing the Compare Side by Side option from the Window menu. Excel stacks the sheets vertically and, like Word, synchronizes them so moving around in one worksheet scrolls the other, letting you compare their contents easily. 

A range of statistical functions—VAR, STDEV, STDEVP, DVAR, FORECAST, SLOPE, INTERCEPT, PEARSON, RSQ, STEYX, and others—have been fixed by changing how they are calculated, to reduce the likelihood they will return incorrect answers. In earlier versions, these functions were known to fail, because of the rounding required where large numbers were involved. 

Other changes include a new Date Smart Tag, which lets you schedule a meeting or display your Outlook Calendar. And a new Person Name Smart Tag lets you get data from an Outlook contact you've recently e-mailed. As with Word, Excel users can remove personal data from a workbook before saving it— although the option is disabled by default. To enable it, choose Tools | Options | Security.


Microsoft Outlook 2003

September 18, 2003
By  M. David Stone 
Microsoft Outlook 2003 is brimming with so many new features that we don't have room to mention them all, much less discuss them in detail. Most important, they're designed well enough that you won't feel overwhelmed. Instead, you'll probably take each change in stride and wonder why Microsoft didn't add it before. 

The obvious changes are those that, taken together, create a significantly different look and feel. When you launch Outlook, you'll notice the vertical Navigation Pane on the left, which is similar to the Folder List. The pane is divided into two sections. At the bottom are buttons for all the categories of data that Outlook handles—tasks, mail, and so on—as well as buttons for shortcuts and the Folder List. Pick a category by clicking on a button, choosing from the new Go menu, or using a shortcut key and the top of the pane will show only folders with that type of data. If you pick Contacts, for example, you'll see a list of folders with contacts, as well as a list of views so you can easily change the viewing format. 

The Navigation Pane does an excellent job of making the myriad forms of data in Outlook easier to work with. Alas, having significantly improved this feature, Microsoft stops short of giving you everything you might want. For example, the pane would be even more useful if you could define new buttons and assign folders to them.

Much of the new look and feel comes from e-mail features. Mail folders show three vertical windows: the Navigation Pane, the list of e-mail messages, and the Reading Pane, which shows the currently selected message. This new arrangement lets you see more text at once. 
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Other welcome enhancements include the ability to add color-coded flags for following up messages, a For Follow Up folder that automatically stores all the messages you've flagged, and an Unread Mail folder—separate from the Inbox—which shows all unread messages no matter what folders they are in. The app also lets you easily group messages by date, size, conversation, subject, and more, and a new visual message alert that includes the sender's name, the subject line, and options to flag, open, or delete the given message. 

In the antispam department, you'll find a junk mail filter that does a decent job of identifying spam and automatically sending it to a junk mail folder. You can also block the program from downloading images and other files when you view or open a message (this is turned on by default), and you can override blocking for specific messages or senders. 

One feature that demands mention even though we weren't able to test it (because we weren't running Microsoft Exchange Server 2003) is the ability to connect securely to an Exchange Server over the Internet without a VPN. Once you've set up this feature, Outlook will first try to connect directly to your Exchange Server. If you're not plugged into your network, however, it will establish a connection over the Internet instead. 

The option to read two calendars side by side is extremely useful. For example, when you're planning a meeting with a coworker, you can bring up both your calendar and hers to check for available time slots.

With Office 2003 Professional Edition, you get Microsoft Outook with Business Contact Manager, which helps you track business contacts and send target marketing e-mail.

All of these features—and more—make Outlook 2003 a significant upgrade. If you use Outlook for e-mail, you'll find a lot to like in the new version, both as an individual and as part of a company. 


Microsoft OneNote 2003

September 18, 2003
By  Ben Z. Gottesman 
Microsoft isn't known for getting its products right on the first release. But Microsoft OneNote 2003, the company's new note-taking program, is one of the best Microsoft debuts we've seen. This handy application provides a single interface for taking notes, which can include formatted text, outlines, graphics, snippets of Web pages, and even drawings. OneNote is very simple to use for entering information and—most important—finding it later on.

Notes are organized into Pages and Subpages. Subpages appear as tabs down the right side of the screen, and Pages appear as tabs at the top of the screen. For one more level of structure, you can store multiple Sections in Folders. 

OneNote is a good solution for creating rich-text outlines. Simply place the cursor anywhere on a page and you can start a new outline. If you have multiple outlines on a page, you can easily drag and drop items among them. You may have to play with the width of each outline section, however, to make things fit properly.

You can easily add pictures to your notes. And if you have a Tablet PC, you can also add handwritten notes, which OneNote can either convert to typed text or simply recognize for searching. Additionally, you can paste pieces of Web pages into OneNote, and the program will automatically generate links to the source. 

OneNote includes an interesting if not yet perfected audio-recording feature. You can record meetings to an audio file, and the application automatically synchronizes the sound with your notes. You can then click the audio icon next to any part of your notes to play back what was recorded at that time. Unfortunately, when we simultaneously recorded a meeting and took notes on our laptop, the recording consisted mostly of the sound of typing on our keyboard. 

Searching is generally very easy. Enter a search word and the program looks through all your notes and lists results, showing the pages in which the item was found. 

Double-clicking on the OneNote icon in the system tray lets you add a Side Note, which looks like a sticky note on a piece of paper but is really a miniaturized version of the complete program. If you enlarge the Side Note window beyond a certain point, the whole application appears.

OneNote is not included in the Office 2003 suite. Like Microsoft FrontPage, Microsoft Visio, and some other Office-related programs, it is sold separately. The program is available for $99 direct, after a $100 rebate.

We'd like to see some security options in OneNote—such as password protection and encryption—as well as true integration with Outlook. While OneNote makes sharing notes via e-mail or SharePoint posting easy, it would be useful if OneNote were used as Outlook's native note format. Similarly, although you can easily create to-do lists within OneNote or turn bits of notes into Outlook Tasks, Microsoft needs to integrate these two concepts.


Should You Upgrade?

September 18, 2003
By  Ben Z. Gottesman 
Through some readers may not know it, Microsoft isn't the only company building suites these days (we review some alternatives here). But in reality, Microsoft Office 2003's biggest competitor is Office XP and earlier versions of the Office suite. 
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Most people already have a version of Office installed. So the big question is: Do you really need to buy this latest iteration? The short answer for the vast majority is no, you don't need to upgrade. Office has been a very competent suite for many years, and you'll get along just fine with whatever version you have. (Of course, the more recent the version the better.) With Office 2003, most of the major enhancements to the core applications, such as Word and Excel, involve improved collaboration capabilities in conjunction with the Office system. These changes have to do with Windows SharePoint Services and SharePoint Portal Server, as well as Office 2003's ability to read and write XML and integrate with Web services to help improve business processes. 

These are great features and are generally well executed in Office 2003. Most businesses should at least consider the upgrade, as the enhancements will improve productivity in any organization that relies on Office applications. For individual users, however, and those without the necessary support to run SharePoint or take advantage of XML, the Office 2003 advantage boils down to some handy new features and interface tweaks. 

Even individuals will find that Office 2003 offers some nice personal productivity enhancements. Nearly every change in Word, Excel, PowerPoint, and Access is for the best. The new Reading View in Word, for example, makes it significantly easier to read documents. But few of these refinements will justify rushing out and purchasing the new Office. 

What might make you rush out, however, is the new version of Outlook, which has had a major overhaul and now makes navigating and reading mail, combating spam, and working remotely much easier. It's a huge step up from an already good mail client.

Microsoft is offering several flavors of Office 2003, so pick the one that best suits your needs. And if you are a home user and do decide to purchase Office 2003, don't ignore the $149 Student and Teacher Edition. If you've ever stepped foot in a classroom, you can buy this version. And business users buying at retail should note that they're eligible for upgrade pricing if they use any version of the suite going back to Office 97 or if they use a fairly recent version of Microsoft Works.

Bear in mind that buying into the Office 2003 system makes you also buy into Microsoft's latest server technology. Many of the new tools in Office 2003, especially those that provide improved collaboration capabilities, will work only in a Microsoft environment.

Microsoft Office 2003 Editions

Pricing

Basic
N/A(1)

N/A(1)

Standard
Student and Teacher
N/A(2)

Small Business
N/A(2)

Professional
Professional Enterprise
Volume Licensing

Volume Licensing

N/A(1)--Not applicable: The product is preinstalled on some PCs and is not available as an upgrade.
N/A(2)--Not Applicable: Upgrades for this edition are not available.

What's Included

Word 2003

Excel 2003

Outlook 2003

Outlook 2003**

Power-
Point 2003

Access 2003

Publisher 2003

InfoPath 2003

Basic
Standard
Student and Teacher
Small Business
Professional
Professional Enterprise
** With Business Contact Manager


The Rest of the Office Gang

September 18, 2003
By Sarah Pike 
There's a lot more to Microsoft Office than Word, Excel, and Outlook. Each program in the suite is available separately, and a few apps are considered part of the Office family but aren't bundled in any edition of Office.

Access 2003
This database program has an improved interface, with a task pane that helps find and correct common errors and reveal object dependencies. Other enhancements include more import/export power and the ability to link tables. (Professional Edition, $229 list.) 

FrontPage 2003
A significant upgrade, this Web site creation and management program adds many new features and controls to previous versions, including Flash support and tools to help you generate JavaScript and XML. ($199.) 

PowerPoint 2003 
The new PowerPoint includes support for smart tags, workgroup collaboration, and information rights management. Multimedia support lets users easily save PowerPoint 2003 files to a CD and play streaming audio and video within a slide show. ($229.) 

Project 2003 
Office's project management program employs flexible reporting and analysis to optimize resources and set work priorities. The Professional version is the client side of Microsoft's enterprise project management solution, which includes links to the company's Project Server and Project Web Access. (Standard, $599; Professional, $999.)

Publisher 2003 
Microsoft's familiar business publishing program now has enhanced Web support, new design sets, improved commercial printing support, an e-mail wizard that lets you preview publications in various e-mail clients, and a catalog-merge feature. (Professional and Small-Business Editions, $169 each; with Digital Imaging, $209.)

Microsoft Visio 2003
Office's diagramming program, Visio 2003, is updated with several new types of diagrams, as well as the kinds of interface improvements seen across the suite. The Professional version, meant for IT pros, engineers, and developers, adds directory services and network rack diagrams. (Standard, $199; Professional, $499.) 


Life Without Office
September 18, 2003
By  Neil J. Rubenking 
Word documents, Excel spreadsheets, and PowerPoint presentations dominate the business world; they've become de facto standards. It seems you can't escape Office even if you're unhappy with its price, its product activation scheme, or Microsoft in general. Fear not, there are numerous less expensive alternatives. While not quite as feature-rich as Office 2003, they handle all common tasks, including reading and writing Office files.

Two major contenders are Sun Microsystems' StarOffice 7.0 Office Suite ($75.95 direct download, www.sun.com/staroffice; [image: image38.png]


) and Corel's WordPerfect Office 11 (Standard, $299.99; Professional, $342, www.corel.com; [image: image39.png]


). Both are powerful equivalents of Word, Excel, and PowerPoint. WordPerfect Professional adds Paradox, a database program.

Microsoft Office users will find switching to StarOffice relatively painless, though they'll need to learn new names for some features. Switching to WordPerfect Office will take more adjustment, as the applications in this suite have had years to evolve their own user interface styles. But unique features like WordPerfect's Reveal Codes and real-time formatting preview can make the switch worth the effort.

StarOffice shares a source code base with the free OpenOffice (www.openoffice.org), which frequently offers newer versions of the applications. Sun tests the applications thoroughly before release, provides support, and also adds useful non-open-source utilities. Businesses will prefer this stability to living on the bleeding edge. And mixed-platform companies will appreciate StarOffice's support for Windows, Linux, and Solaris.

Both programs warn of possible data loss when saving in a Microsoft format—a problem we observed first-hand. After several rounds of editing this article in Word, WordPerfect, and StarOffice, we found that StarOffice's spell-checker marked every word as misspelled, and Word would not open it at all. We recommend saving files in your application's native format and exporting to the corresponding Office format only when needed.

Other alternatives include Gobe Corp.'s gobeProductive 3.0 ($99.95, www.gobe.com), an all-in-one application that provides the functions of a suite, and E-press's EasyOffice (free for personal use, www.e-press.com), which includes 19 distinct applications. For more on these and other choices, see "The Office Alternatives" (March 18, 2002).


XML in Action in Office 2003
September 18, 2003
Microsoft Office 2003 lets people use the products they're familiar with to write data to and read data from external data sources using XML and Web Services. This example shows how a user familiar with Excel can complete an expense report. The data can be written directly to a back-end expense-tracking database rather than lying captive inside an XLS file. Another Excel user (with the appropriate rights) can then tap into the database to analyze the expense data.

Click here to view the example.

Copyright (c) 2004 Ziff Davis Media Inc. All Rights Reserved. 
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NEW YORK--Microsoft on Tuesday released what its executives touted as one of the most significant product updates in the company's history: a fresh version of  Office with extensive new hooks into corporate computing systems.  During a speech at the main Office System launch event here, Microsoft Chairman  Bill Gates said the new software line--which combines familiar Office  productivity programs with new business applications--ushers in a broad new role  for Office as the common interface for creating and interacting with corporate data. 

News.context

What's new:

Microsoft's new version of its Office software package, Office System, combines 

familiar Office productivity features with new business applications. 

Bottom line:

For the most part, companies have waited for bug fixes and the like before 

widely implementing new versions of Office. Still, the sophisticated 

server-related and XML functions in Office System could extend such delays, 

potentially limiting the moneymaking clout of Microsoft's software package.

More stories on this topic 

"We're introducing more software products in a single day than any day in our 

history," Gates said. "Every one of these products is about sharing information 

and collaborating." 

The most significant part of Office System is Office 2003, the productivity 

package widely used to create documents, spreadsheets and other business 

materials. While previous Office upgrades have focused on new tools and 

services, the most significant updates in Office 2003 are under the hood, such 

as dramatically enhanced support for Extensible Markup Language (XML), the 

fast-spreading standard for exchanging data between disparate computing systems. 

Broad XML support will allow Office applications to serve as a general container 

for exchanging data with corporate databases and other back-end systems, and for 

tapping Web services and other tasks that normally would require separate client 

software. 

"Office, which has always been extremely important to personal 

productivity...now becomes a workspace for team and organizational 

productivity," said Jeff Raikes, a Microsoft group vice president. 

"I think these advances would not have been possible without the industry's 

commitment to XML and Web services," Gates added. "This is definitely becoming 

the common way that all the software on the Internet connects together." 

XML support has attracted broad interest from other technology companies, with 

more than 700 partners introducing Office-related products and services at the 

launch, and hundreds more in development. Backers range from small specialty 

software makers to computing giants such as Hewlett-Packard, which built several 

new solutions and services packages around Office System products, particularly 

SharePoint collaboration tools. 

Bill Carlisle, director of HP's Microsoft solutions group, said Office 2003 has 

created numerous opportunities for HP as a systems integrator, creating the 

connections between Office applications and server resources. 

"You can take the technology and package it in a lot of different ways to 

address specific customer needs," he said. 

As a hardware seller, HP sees Office 2003's efficient use of back-end resources 

as a good argument to get business to update their server installations, 

Carlisle said. "If you look just at messaging systems, there's huge potential 

for server consolidation." 

Office 2003 also introduces digital rights management to the software, with 

support for server-based tools that let office workers restrict access to 

documents. The technology has provoked controversy because it requires 

compatible Microsoft server technology and prevents competing productivity 

software, such as the open-source OpenOffice, from reading protected files. But 

Microsoft expects the technology to be a quick hit with businesses that deal 

extensively in sensitive documents, such as legal and financial offices. 

An array of applications

Besides Office 2003, Office System includes several new applications. InfoPath 

is Microsoft's entry in the emerging market for electronic forms, online 

documents that automatically route data entered to relevant back-end computing 

systems. InfoPath is expected to have a slow start, mainly attracting companies 

looking to automate internal business processes. 

      News.commentary

      An enterprise push 

      for Office

      Microsoft's upgrade is designed

      to help wire employees together

      and link them into enterprise

      data and processes.

Gates said InfoPath addresses a growing need Microsoft identified several years 

ago for an application focused on presenting highly structured information and 

delivering it to corporate computing systems. "We realized there was a missing 

piece in Microsoft Office," he said. 

OneNote is Microsoft's new application for taking notes and organizing them with 

research data from other sources. Target markets for the application include 

college students and the slowly growing audience of Tablet PC users. 

Several existing products also have been folded into Office System, including 

SharePoint, Microsoft's line of server products for collaboration and 

information sharing, and Live Meeting, the company's stab at videoconferencing. 

"Collaboration is the theme of this release," Gates said. "How do you share 

information?" 

Tuesday also marked the release of several products affiliated with, but not 

actually part of, Office System, most notably Exchange 2003, the new version of 

Microsoft's e-mail server software. Changes in Exchange 2003 include numerous 

filtering and organizing tools that work in conjunction with Outlook, the e-mail 

client included in Office 2003, to reduce exposure to junk e-mail and make it 

easier to find relevant messages, Gates said. 

Specific enhancements include a revamped version of Outlook Web Access, the set 

of Exchange features used to allow e-mail access via the Web. "People want 

e-mail on every device, everywhere they go," Gates said. "Historically, if you 

did e-mail through the browser, it was a very limited experience. You 

essentially had to learn a different user interface than Outlook. The basic 

interface (in Outlook Web Access) now is exactly the same as Outlook." 

Caching enhancements in Outlook and Exchange also store e-mail much more 

efficiently, allowing geographically diverse companies to cut back their e-mail 

infrastructure, Gates said. "Microsoft has gone from 56 places with Exchange 

servers down to seven," he said. 

Exchange 2003 also offers enhancements intended to warm the hearts of IT 

administrators, including direct support for remote connections, eliminating the 

need for virtual private networking (VPN) support, said Melissa Stern, a 

Microsoft product manager. "If a company is providing VPN access purely for 

messaging, this eliminates the need for that," she said. "That cuts a lot of 

cost and support calls right there." 

Security and privacy have been enhanced in Exchange, through increased support 

for third-party antivirus and antispam products. "We've provided a lot more 

hooks for third-party vendors to plug into," Stern said. 

Exchange 2003 also comes with a full set of integration and migration tools for 

businesses upgrading from Exchange 5.5, the 5-year-old version of the software 

that still accounts for the majority of Exchange installations. 
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Offline Folders 

Offline folders are the quickest and easiest way to work offline. Offline folders make it possible to take a folder from a location, work with the contents of the folder when you are not connected to the network, and then update the folder and its corresponding server folder to make the contents of both identical. This process is called synchronizing folders. 

You can add, delete, and modify the contents of an offline folder exactly as you can with a folder on a server. For example, you can change and move items in your offline Inbox, send messages that are placed in your offline Outbox, and read your offline public folders. Meanwhile, you will receive new messages in your Inbox on the server, but you will not be aware of these changes on the server until you synchronize. 

Offline folders are stored in the offline folder (.ost) file. This file is located on your computer hard disk and is available even when the network is down. 

Create an offline folder file 
• Click Inbox . 
• On the Tools menu, click Services. 

• In the The following information services are set up in this profile box, click Microsoft Exchange Server. 

• Click the Properties button. 

• In the Microsoft Exchange Server properties window, click the Advanced tab. 

• Click Offline Folder File Settings. 

• In the File box, type or browse to the file you want to use as the offline folder file. The default pathway is to your profile on your hard drive. 

• Click OK until you exit. 

Once you have set Outlook to work offline, you’ll need to set up which folders to work when you are offline. 

• Click Tools in the Menu bar 

• Click Synchronize 

• In the drop down menu, choose Offline Folder 

Settings… • lick the plus sign • OK Choose the All Folders tab to check the folders that you want to be available when working offline 

Note: your default folders are always available. Expand the folder (c) to choose a folder you have created. 

Click 

When you exit Outlook, your folders will take a moment to synchronize with your Drive “C”. 

If you want to synchronize them manually, click Tools, Synchronize, then choose: 1. Mail and Calendar, This Folder, or All Folders 

http://office.microsoft.com
Create an Offline Folder file (.ost)

Hide All

This feature requires you to be using a Microsoft Exchange Server e-mail account.

An Offline Folder file (.ost) (Offline Folder file: The file on your hard disk that contains offline folders. The offline folder file has an .ost extension. You can create it automatically when you set up Outlook or when you first make a folder available offline.) is used to keep a local copy of your Exchange Server mailbox on your computer. The items in your .ost file are synchronized with the server when a connection is available.

1. On the File menu, click Work Offline. 

2. Select or clear the Prompt me at startup so I may choose to work offline or online check box, and then click OK. 

If you clear the check box, Outlook will automatically start offline if a connection to the server is not available.

3. Click Yes to copy the data from the server to your new Offline Folder file (.ost).

Note  In Microsoft Office Outlook 2003, a new offline folder file format is introduced that offers greater storage capacity for items and folders and supports multilingual Unicode (Unicode: A character encoding standard developed by the Unicode Consortium. By using more than one byte to represent each character, Unicode enables almost all of the written languages in the world to be represented by using a single character set.) data. A file created in this format is not compatible with previous versions of Outlook and cannot be opened in a previous version of Outlook. Outlook automatically determines the format in which the offline folder file is created based on the version of the Microsoft Exchange Server, administrator settings, and formats of the data files that are configured for the profile. If the settings do not allow the file to be created in the new format, Outlook creates the file in the format that is compatible with previous versions of Outlook that does not support Unicode and offers the same storage capacity that was available in previous versions of Outlook.

http://office.microsoft.com 

Select Exchange folders available offline
This feature requires you to be using a Microsoft Exchange Server e-mail account.


Use offline folders with Exchange Server

1. If you are not already connected to the network, do so by using a dial-up connection. You can specify a dial-up connection from Outlook. 

This feature requires Microsoft Exchange.

If you are using a different e-mail service, see Windows Help for information about setting up a dial-up connection.

1. On the Tools menu, click E-Mail Accounts, click View or change existing e-mail accounts, and then click Next. 

2. In the list, click Microsoft Exchange Server, and then click Change. 

3. Click More Settings. 

4. Click the Connection tab, and then click Connect using my phone line. 

5. Under Modem, click the appropriate dial-up connection in the list, or click Add and follow the instructions in the wizard to create a new connection. 

2. Create an Offline Folder (.ost) file. 

1. On the File menu, click Work Offline. 

2. Select or clear the Prompt me at startup so I may choose to work offline or online check box, and then click OK. 

If you clear the check box, Outlook will automatically start offline if a connection the server is not available.

3. Click Yes to copy the data from the server to your new Offline Folder file (.ost).

Note  In Microsoft Office Outlook 2003, a new offline folder file format is introduced that offers greater storage capacity for items and folders and supports multilingual Unicode (Unicode: A character encoding standard developed by the Unicode Consortium. By using more than one byte to represent each character, Unicode enables almost all of the written languages in the world to be represented by using a single character set.) data. A file created in this format is not compatible with earlier versions of Outlook and cannot be opened in an earlier version of Outlook. Outlook automatically determines the format in which the offline folder file is created based on the version of the Microsoft Exchange Server, administrator settings, and formats of the data files that are configured for the profile. If the settings do not allow the file to be created in the new format, Outlook creates the file in the format that is compatible with earlier versions of Outlook that do not support Unicode and offer the same storage capacity that was available in earlier versions of Outlook.

3. Specify the folders you want to be available for offline use. 

The Inbox, Outbox, Deleted Items, Sent Items, Calendar, Contacts, and Tasks folders are automatically made available offline when you set up offline folders. To use any other folder offline, you must specifically select it for offline use by following the steps below.

1. On the Tools menu, point to Send/Receive, point to Send/Receive Settings, and then click Define Send/Receive Groups.

2. In the list, click a Send/Receive group containing an Exchange Server account, and then click Edit. 

3. Under Accounts, select your Exchange Server account. 

4. Under Folder Options, select the folders that you want to use offline. 

5. Click one of the following: 


Download only headers

· Select Download headers only.


Download complete items including attachments

· Select Download complete item including attachments. 

You can limit downloads of items exceeding a specified size to headers only. Select the Download only headers for items larger than check box, and then enter the size limit that you want in kilobytes (KB).


Use Cached Exchange Mode

When you use Cached Exchange Mode, all of your Exchange server folders are available automatically. 

1. Turn on Cached Exchange Mode. 


How?

1. On the Tools menu, click E-Mail Accounts, click View or change existing e-mail accounts, and then click Next. 

2. In the Outlook processes e-mail for these accounts in the following order list, click the Microsoft Exchange Server account, and then click Change. 

3. Under Microsoft Exchange Server, select the Use Cached Exchange Mode check box. 

4. Exit and then restart Outlook. 

2. Specify the folders you want to be available for offline use. 


How?

1. On the Tools menu, point to Send/Receive, point to Send/Receive Settings, and then click Define Send/Receive Groups.

2. In the list, click a Send/Receive group containing an Exchange Server account, and then click Edit. 

3. Under Accounts, select your Exchange Server account. 

4. Under Folder Options, select the folders that you want to use offline. 

5. Click one of the following: 


Download only headers

· Select Download headers only.


Download complete items including attachments

· Select Download complete item including attachments. 

You can limit downloads of items exceeding a specified size to headers only. Select the Download only headers for items larger than check box, and then enter the size limit that you want in kilobytes (KB).


Tip

To quickly designate a folder for offline use, click the folder in the Navigation Pane (Navigation Pane: The column on the left side of the Outlook window that includes panes such as Shortcuts or Mail and the shortcuts or folders within each pane. Click a folder to show the items in the folder.) and on the Tools menu, point to Send/Receive, point to Send/Receive Settings, and then click Make This Folder Available Offline.
Note  If you are using dial-up networking to work with offline folders from a remote location, you must first set up your computer with a modem, a telephone line, and dial-up networking software.

http://support.microsoft.com/default.aspx?scid=kb;en-us;293162
Microsoft Knowledge Base Article - 293162    
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OL2002: How to use Outlook 2002 Group Schedules

View products that this article applies to.

This article was previously published under Q293162 

SUMMARY

Microsoft Outlook 2002 has a new feature called Group Schedules. This article details the functionality of the Group Schedules feature. 

MORE INFORMATION

Group Schedules enable you to view the combined schedules of individuals, resources or Calendar public folders, and schedule meetings with the entire group or with individual members of the group. In previous versions of Outlook, a meeting request was created and populated to achieve this. With Group Schedules, this grouping can be saved for later access. 

How to Create Group Schedules

You can create a Group Schedule in a Calendar folder or a Calendar public folder on a Microsoft Exchange Server. Group Schedules that you create in an Exchange public folder can be used by others that have access to that public folder.

Use the following steps to create a new Group Schedule and add group members: 

Locate the desired Calendar folder.

Click the Actions menu, click View Group Schedules, or click the Schedules button on the Standard toolbar. 

In the Group Schedules dialog box, click New.

In the Create New Group Schedule dialog box, type a descriptive name for the new Group Schedule. Verify the name before you click OK because you cannot change the name later.

Click OK.

To add Group Members, type a user name, e-mail address or e-mail alias, or click the Add Others button, and then select to add users from an Address Book.

After you add the desired group members, click Save and Close.

You can now open the new Group Schedule the View Group Schedules dialog box. 

How to Add Public Folders

Adding a Calendar Public Folder to a Group Schedule displays the Free/Busy information for that Calendar Public Folder. This is useful when multiple users store appointments or meeting information in an Exchange Calendar public folder. To add a Calendar public folder as a Group Member, use the following steps: 

Locate the desired Calendar folder.

Click the Actions menu, click View Group Schedules, or click the Schedules button on the Standard toolbar.

In the Group Schedules dialog box, click the Group Calendar that you want to modify, and then click Open. If a Group Schedule does not yet exist, view the "Creating Group Schedules" section of this article.

Click OK.

To add a Calendar public folder to Group Members, click the Add Others button, and then click to add a public folder.

In the Select Folder dialog box, locate a Calendar public folder, and then click OK.

After you add the desired Calendar public folder, click Save and Close.

The Group Schedule Dialog Box

The Zoom Drop-Down List Box

The Zoom drop-down list box enables you to see additional or fewer hours in the Free/Busy information dialog box. The Group Schedule dialog box can be maximized or resized, as needed. 

Options button

Clicking the Options button displays a menu. In the menu, the Show Working Hours option appears. If this option is enabled, it only show working hours, based on the setting found when you click the Tools menu, click Options, and then click the Calendar Options button in the Preferences tab. Also, the Options button has the option to Refresh Free/Busy information. 

The Make a Meeting Button

Clicking the Make Meeting button displays a menu. In the menu, you have options to create a new meeting with the selected Group Member or with all Group Members. If the selected Group Member is a resource (conference room, shared office equipment, etc.), you can select to schedule a meeting with that Group Member as a resource. Also, the Make Meeting button has options to e-mail the selected Group Member or all Group Members.

How to Use Group Schedules in a Microsoft Exchange Server Environment

Viewing Calendar Details

Clicking Options in the Group Schedule dialog box displays a menu with the option to Show Calendar Details. When you click to select the Show Calendar Details option, the Free/Busy details for appointments and meetings appear in the Free/Busy dialog box if the Exchange Server mailbox owner has given you at least Reviewer permissions to their Calendar folder. 

Viewing Private items

Items marked as Private will not display Free/Busy details unless the shared Calendar owner gives you delegate control to their Calendar and check the option to enable delegates to view Private items. The delegate can configure that setting by checking the Delegate can see my private items check box, which can be accessed by clicking on the Tools menu, clicking Options, and then clicking the Permissions button on the Delegates tab. 

Sharing Group Schedules

You can share Group Schedules by creating them in a Calendar public folder. You must have Owner permissions to the Calendar public folder before you can create Group Schedules in it. Assign permissions to the Calendar public folder for those that you would like to access that Group Schedules.

Known Issues

Microsoft ActiveSync 3.1 does not recognize Group Schedules.

When you use ActiveSync 3.1 to synchronize your Outlook Calendar, Group Schedules stored in the Calendar folder also synchronize, but appear as unrecognizable appointment items. The appointment subject on the handheld may contain a long string, similiar to "{B911D251-1842-4720-A131-F164B6C99078}" (without the quotation marks).

Do not delete the item on your handheld computer because this may delete the Group Schedule from Outlook the next time you synchronize. Also, when you create and save a new Group Schedule, you may receive the following error message: 

One appointment cannot be read from Microsoft Outlook due to error 80180b04.

This item will not be synchronized with the mobile device.

Appointment {B911D251-1842-4720-A131-F164B6C99078} - My Team's Schedule

Start: 10/26/2001 5:00:00 P.M.

End: 10/26/2001 6:00:00 P.M. 

Microsoft has confirmed that this is a problem in Microsoft ActiveSync 3.1. This issue was fixed in Microsoft ActiveSync 3.5. For information on how to obtain the newest version of ActiveSync, please visit the following Web site: 

http://www.microsoft.com/mobile/pocketpc/downloads. 

The information in this article applies to:

Microsoft Outlook 2002

http://office.microsoft.com
Synchronize offline folders
Help
Assistance > Outlook 2003 > E mail > Working Offline
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You can automatically synchronize your offline folders at a time or time intervals that you specify, or you can manually synchronize them whenever you need to. Whether you synchronize automatically or manually, you must first have specified the folders for offline use.

You must first set up Microsoft Outlook to work offline and, if using an Exchange Server e-mail account, select the Exchange folders you want available offline.


Manually synchronize folders

Do one of the following:

· To synchronize the selected folder, click the Tools menu, point to Send/Receive, and then click This Folder. 

· To synchronize all of your folders that are set up for offline use, click the Tools menu, point to Send/Receive, and then click Send/Receive All. 

· To synchronize a Send/Receive group of folders, click the Tools menu, point to Send/Receive, and then click the name of the Send/Receive group. 


Automatically synchronize folders

1. On the Tools menu, point to Send/Receive, point to Send/Receive Settings, and then click Define Send/Receive Groups. 

2. Under Group Name, select a send/receive group group. 

3. Do either or both of the following: 


Set up online synchronization

Under Setting for group Send/Receive group name, select the check boxes that you want: 

· To automatically synchronize all folders at specified intervals while you're online, select the Schedule an automatic send/receive every x minutes check box, and then enter a number between 1 and 1440. 

· To synchronize all folders after every online Microsoft Outlook session, select the Perform an automatic send/receive when exiting check box. 


Set up offline synchronization

Under When Outlook is offline, select the check boxes that you want: 

· To automatically synchronize all folders at specified intervals while you're online, select the Schedule an automatic send/receive every x minutes check box, and then enter a number between 1 and 1440. 

Note  If you are using Cached Exchange Mode with a Microsoft Exchange Server e-mail account, a copy of the your Exchange mailbox is kept on your computer in an Offline Folder file (.ost). (Offline Folder file: The file on your hard disk that contains offline folders. The offline folder file has an .ost extension. You can create it automatically when you set up Outlook or when you first make a folder available offline.) This allows you to work uninterrupted online or offline. Your data is automatically synchronized and this procedure is not necessary.

http://www.brienposey.com/kb/outlook_autosynch.asp
Configuring Outlook’s Offline Folders For Automatic Synchronization

By Brien M. Posey

Outlook is designed so that any time you work offline, any updates that you make or messages that you compose are stored to an offline folder. The next time that you connect to the Exchange Server, the offline folder is automatically synchronized with the server. When working offline, you might have noticed that Outlook is running at limited capacity. For example, you may not have access to the full Global Address List or to all of your public folders. However, Outlook’s offline folders are highly customizable, and you can make just about anything available offline that you have access to when you’re connected to the server. On the flip side, if you find that the synchronization process takes too long or if your laptop is low on disk space, you can configure Outlook not to synchronize the things that you never use or that you don’t need access to while offline.

 There are actually three different types of automatic synchronization. You can select which type of automatic synchronization that Outlook should use by selecting the Options command from Outlook’s Tools menu. When you see the Options properties sheet, select the Mail Services tab. Here you have access to the three synchronization options, as shown in Figure A. Keep in mind that the synchronization options aren’t exclusive; you can use any combination of the options that I’m about to discuss.

Figure A
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The first option is When Online, Synchronize All Folders Upon Exiting. This option should almost always be used. It ensures that when you close Outlook after working online that you’ll have the most up to date information possible.

 The next option is When Online, Synchronize. This option can be a time saver because you can synchronize every hour or so throughout the day rather than having to synchronize a full days worth of information at the end of the day. You can select how often synchronization should occur and which folders should be synchronized.

 The final synchronization option is the When Offline Synchronize option. This command works exactly the same way as the When Online Synchronize option. The only difference is that synchronization is accomplished by establishing a dial up networking session and synchronizing the requested folders before returning to an offline state.

 At the bottom of Figure A, you might have noticed the Offline Folder Settings button. If you click this button, you’ll see the Offline Folder Settings properties sheet, shown in Figure B. The All Folders tab allows you to select which folders are included when synchronizing all folders. You can add or remove folders from the list be selecting or deselecting the corresponding check box. 

 Figure B
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You can also control whether or not you want the offline address book to be downloaded. Clicking the Settings button allows you to determine which address book you want to download and whether or not you also want to download the address book’s full details. The default option is to download the full details of the Global Address List.

 The Offline Folder Settings properties sheet also allows you to determine whether or not you want to synchronize forms or folder home pages, by simply selecting or deselecting a check box. 

 Beneath the options that I just described is the Download Options button. When you click this button, you’ll see the Download Options dialog box, shown in Figure C. As you can see in the figure, this dialog box provides you with even more control over the automatic synchronization process. For example, you can tell Outlook not to download messages over a certain size. You can also set exception rules so that Outlook will go ahead and download a large message if it’s from a specific user, is marked as high priority, or has been flagged with any number of other criteria.

 Figure C
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The final option that I wish to discuss is the Filter Selected Folder option. When you select a folder and click the Filter Selected Folder button on the Offline Folder Settings properties sheet, you’ll see the Filter properties sheet. This properties sheet allows you to narrow down what’s synchronized by filtering specific criteria. You can filter just about anything. Some examples are a message sent from, a message sent to, a file size, unread items, items with attachments, etc. The list goes on and on.

 You might have also noticed the Quick Synchronization tab on the Offline Folder Settings properties sheet. The Quick Synchronization tab isn’t a part of the automatic synchronization. Instead, it allows you to create a menu item that allows you to manually synchronize the items that you’ve selected, with a single mouse click.

 As you can see, automatic synchronization doesn’t have to take forever to complete or leave you feeling like you’re missing critical resources. You can control exactly which items get synchronized.

If you've found this article helpful and you aren't already a member of this site, then please register for a free membership. With your membership you'll receive access to our Question and answer forum where you can ask all of your toughest technical questions. You'll also receive our tip of the week E-mailed directly to you. We hate junk mail just as much as you do, and it is our policy not to send out advertisements unless they are accompanied by legitimate technical content.

http://www.lsa.umich.edu/lsait/outlook/techfaqs/syncoutlook2000.html
Offline Outlook folders (Outlook 2000)

This technote is based primarily on content found in Outlook 2000 Online Help.

Overview
Offline Outlook folders enable you to work with information stored in Outlook when you are not connected to the network (when you are offline).

For example, you can read messages in your Inbox, compose new outgoing messages and manage appointments on your Calendar -- all without a network connection.

Offline Outlook folders are particularly useful if you are a laptop user who needs to access Outlook information from a location where network connectivity is inconvenient or impossible: an airport, a restaurant, a client's office, etc.

Offline Outlook folders are stored in an offline folder file which is located on your computer's local hard drive.

Offline Outlook folders are a mirror image of your Outlook folders stored on the Exchange server.  Offline Outlook folders kept current through a process called "synchronization" which also sends any outgoing mail that you compose while offline.

Begin using offline Outlook folders
Connect your computer to the Internet (campus Ethernet, phone modem dial-up, cable modem, DSL, etc.) and then start Outlook. 

1. In the Tools menu, click Services. 

2. In the Services window that appears, click on the Services tab. 

3. Under The following information services are set up in this profile, click on Microsoft Exchange Server and then click on the Properties button. 

4. Click on the Advanced tab and then click on Offline Folder File Settings... 

5. In the File box, type a path (hard drive location) and filename for the offline folder file.  Use a path on your local hard drive and give the filename an .ost extension (the default path and filename are usually good choices). 

6. Click OK. 

7. Put a check in the box next to Enable offline use and click OK. 

Specify your offline Outlook folders
The Inbox, Outbox, Deleted Items, Sent Items, Calendar, Contacts, Tasks, Journal, Notes, and Drafts folders are automatically made available offline when you set up offline folders.

To use any other folder offline, you must specifically enable it for offline use by following the steps below. 

Connect your computer to the Internet (campus Ethernet, phone modem dial-up, cable modem, DSL, etc.) and then start Outlook.

1. in the Tools menu, point to Synchronize, and then click Offline Folder Settings. 

2. In the list, select the folders that you want to use offline in addition to your default folders. 

3. If you want to apply a filter to a specific folder, click the folder, click Filter Selected Folder, and then select the options that you want. 

4. If you want to use the Global Address List while offline, put a check next to the Download offline address book. 

5. Click OK. 

Synchronize your offline Outlook folders 
Connect your computer to the Internet (campus Ethernet, phone modem dial-up, cable modem, DSL, etc.) and then start Outlook.

· To synchronize a selected folder, click the Tools menu, point to Synchronize, and then click This Folder. 

· To synchronize all of your folders that are set up for offline use, click the Tools menu, point to Synchronize, and then click All Folders.

You can typically use the F9 key to synchronize all of your offline Outlook folders. 

Tips 
· The offline folder file may be deleted during maintenance performed by IT staff.  The offline folder file will be recreated the next time that you synchronize.  However, you should still synchronize often to ensure that you changes are copied to the server in a timely manner. 

· Synchronizing for the first time (or when you haven't synchronized in while) can take a long time.  Be patient! 

· Only synchronize those Outlook folders that you really need to have available offline.  Having large numbers of offline Outlook folders will increase synchronization time. 

· Having Large numbers of offline Outlook folders also increases the possibility of a corrupted offline folder file, which will cause Outlook to stop functioning normally. 

· Outlook may sometimes appear to "hang" while synchronizing.  Again, be patient and give the process a few minutes to finish. 

· Synchronizing with a phone modem is much slower than with the campus network. 

Google.com

Thursday, March 25, 2004 

Meeting the Googlers 

Set the TiVo! This Sunday morning, "CBS News Sunday Morning" will begin with my report on Google, the Web search page-slash-cultural deity that's expected to go public this Spring — the biggest in high-tech history, with a valuation as high as $25 billion. 

It was a real kick to interview Google's executives and staff. Along the way, I asked each interview subject to name their favorite Google tips and tricks. 

Few of the tricks made it into the TV segment — but you, the shrewd subscriber to this newsletter, get them hot off the press. 

• Download and install the Google toolbar. Not only does it put the Google search box into your browser full-time, but it also blocks pop-up ads and fills in forms for you. For Windows at http://toolbar.google.com. (Ad blocking, form-filling and Google's search box are already built into the Apple's Web browser, Safari.) 

• Phrase your question in the form of an answer. "After all, you're not looking for Web pages that ask your question," explains director of technology Craig Silverstein. "You're looking for pages that answer it."

So instead of typing, "What is the average rainfall in the Amazon basin?", you might get better results by typing "The average rainfall in the Amazon basin is." 

• This is an old one, but very important: Put quotes around phrases that must be searched together. If you put quotes around "electric curtains," Google won't waste your time finding one set of Web pages containing the word "electric" and another set containing the word "curtains." 

• Similarly, put a hyphen right before any word you want screened out. If you're looking up dolphins, for example, you'll have to wade through a million Miami Dolphins pages unless you search for "dolphins -Miami." 

• Google is a global White Pages and Yellow Pages. Search for "phonebook:home depot norwalk, ct," Google instantly produces the address and phone number of the Norwalk Home Depot. This works with names ("phonebook:robert jones las vegas, NV") as well as businesses. 

Don't put any space after "phonebook." And in all of the following examples, don't type the quotes I'm showing you here. 

• Google is a package tracker. Type a FedEx or UPS package number (just the digits); when you click Search, Google offers a link to its tracking information. 

• Google is a calculator. Type in an equation ("32+2345*3-234="). Click Search to see the answer. 

• Google is a units-of-measurement converter. Type "teaspoons in a gallon," for example, or "centimeters in a foot." Click Search to see the answer. 

• Google is a stock ticker. Type in AAPL or MSFT, for example, to see a link to the current Apple or Microsoft stock price, graphs, financial news and so on. 

• Google is an atlas. Type in an area code, like 212, to see a Mapquest map of the area. 

• Google is Wal-Mart's computer. Type in a UPC bar code number, such as "036000250015," to see the description of the product you've just "scanned in." (Thanks to the Google Blog, http://google.blogspace.com, for this tip and the next couple.) 

• Google is an aviation buff. Type in a flight number like "United 22" for a link to a map of that flight's progress in the air. Or type in the tail number you see on an airplane for the full registration form for that plane. 

• Google is the Department of Motor Vehicles. Type in a VIN (vehicle identification number, which is etched onto a plate, usually on the door frame, of every car), like "JH4NA1157MT001832," to find out the car's year, make and model. 

• For hours of rainy-day entertainment, visit http://labs.google.com. Here, you'll find links to new, half-finished Google experiments-like Google Voice, in which you call (650) 623-6706, speak the words you want to search for and then open your browser to view the results. Disclaimer: It wasn't working when I tried it. (Ditto a lot of these experiments.) 

• Poke around the "Services & Tools" link on the Google.com home page and you'll find some of the better-known lesser-known Google features, if that makes any sense. 

For example, there's Froogle (product search), News, Groups (Internet discussion boards), Google Catalogs (hundreds of scanned-in product catalogs), Images (find graphics and photos from other people's Web sites), Blogger (publish your own online journal), Google language translation, Google Answers (pay a couple of bucks to have a professional researcher find the answers for you) and much more. 

Pretty soon you'll need Google just to search Google! 

Visit David Pogue on the Web at DavidPogue.com.
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